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รู้จักกับโปรแกรม Adobe Illustrator CC

Illustrator คือ โปรแกรมที่ใช้ในการวาดภาพ โดยจะ
สร้างภาพที่มีลักษณะเป็นลายเส้น หรือที่ เรียกว่า 
Vector Graphic จัดเป็นโปรแกรมระดับมืออาชีพที่ใช้
กันเป็นมาตรฐานในการออกแบบระดับสากลสามารถ
ท างานออกแบบต่างๆ ได้หลากหลาย ไม่ว่าจะเป็น
สิ่งพิมพ์ บรรจุภัณฑ์ เว็บ และภาพเคลื่อนไหวตลอดจน
การสร้างภาพเพื่อใช้เป็นภาพประกอบในการท างานอื่นๆ 
เช่น การ์ตูน ภาพประกอบหนังสือ



งานที่ออกแบบด้วยโปรแกรม Adobe Illustrator CC

บรรจุภัณฑ์

โลโก้

สิ่งพิมพ์

เว็บไซต์



อะไรคือ Adobe Creative Cloud?



อะไรคือ Adobe Creative Cloud?

Adobe Creative Cloud คือ ชุดโปรแกรมจากค่าย 
Adobe ที่ได้รวบรวมเอาเครื่องมือทุกอย่างที่ต้องการ
ส าหรับนักออกแบบกราฟฟิก หรือ Creative เพื่อใช้
เนรมิตสร้างสรรค์ผลงานที่ดีที่สุดออกมา โดยสามารถ
ท างานได้ทั้งบนหน้าเครื่องคอมพิวเตอร์เดสก์ท็อป และ
บนคลาวด์ (Cloud) ซึ่งจะสามารถเชื่อมต่อหรือแชร์ไฟล์
ผลงาน รวมทั้งสร้างและแก้ไขไฟล์ได้ทุกที่ทุกเวลา



Adobe Creative Cloud ดีอย่างไร?

- Upgrade โปรแกรมเวอร์ชั่นใหม่ๆ ได้ฟรีตลอดอายุการใช้งาน
- สามารถ update โปรแกรม patch ปรับปรุง plugin หรือ Feature ใหม่ๆ ได้ตลอดอายุ

การใช้งาน
- ฟรี พื้นที่เก็บไฟล์ออนไลน์  Cloud storage สูงสุดถึง 100 GB สามารถเก็บไฟล์งานที่ส าคัญ  

หรือแชร์ไฟล์งานต่อให้เพื่อนร่วมงานได้จากทุกๆ ที่และทุกๆ device สะดวกรวดเร็วต่อการ
สร้างสรรค์งานยิ่งขึ้น

- มี Admin Console เพ่ือให้คุณ Manage License ของเราได้ เช่น การเพ่ิม ลบ 
เปลี่ยนแปลงสิทธ์ิการใช้งาน ของ user ได้

- มี Expert Support จาก Adobe โดยตรง รวมถึง Support จาก I.T. Solution 
Computer(Thailand) Co.,Ltd. เองด้วย เพื่อที่จะรับปรึกษาหรือแก้ปัญหา ไม่ว่าจะเป็น
ในส่วนของการใช้งานโปรแกรม หรือในส่วนของการติดตั้งโปรแกรม ฯลฯ



สวนประกอบของหนาจอ

โปรแกรม Adobe Illustrator



คอนโทรลพาแนล (Control Panel) แถบเมนูคำสั่ง

กลองเครื่องมือ (Tool Box) พื้นที่การทำงาน (Artboard) พื้นที่ภายนอก (Scratch area)
ใชวางพักวัตถุที่ยังไมไดใชงานในขณะนั้น

กรอบจัดเก็บพาเนล (DockPanel)



File: เปนหมวดของคำสั่งที่จัดการเกี่ยวกับไฟลและโปรแกรมทั้งหมด ไมวาจะเปนการ เปด-ปดไฟล การ บันทึกไฟล การนำภาพเขามาใช (Place) 

ตลอดจนการออกจากโปรแกรม (Exit)

Edit: เปนหมวดของคำสั่งที่จัดการแกไข เชน Undo Cut Copy Paste Select รวมทั้งการกำหนดคุณสมบัติ ตางๆ ที่มีผลตอการปรับแตงภาพดวย 

เชนการสรางรูปแบบ (Define Pattern) การกำหนดคาสี (Color Setting) เปนตน

Type: เปนหมวดของคำสั่งที่ใชจัดการตัวหนังสือ เชน Fonts Paragraph เปนตน

Select: เปนหมวดของคำสั่งที่ใชในการเลือกวัตถุ สามารถเลือกดวยคุณสมบัติได เชน เลือกวัตถุที่มี Fill และ Stroke แบบเดียวกัน 

วัตถุที่อยูบน Layer เดียวกัน เปนตน

Filter: เปนหมวดของคำสั่งที่ใชสรางเทคนิคพิเศษใหกับภาพ โดยจะมีผลตอรูปรางของ Path

Effect: เปนหมวดของคำสั่งที่ใชสรางเทคนิคพิเศษใหกับภาพคลาย Filter แตจะไมมีผลกับรูปรางของ PathView: เปนหมวดของคำสั่งเกี่ยวกับ

การมองทุกสิ่งในงาน เชน Zoom Show/Hide Ruler Bounding Box Outline Mode/Preview Mode เปนตน

Window: เปนหมวดของคำสั่งเกี่ยวกับการเปด-ปดหนาตางเครื่องมือตางๆ เชน Palette Tool Box เปนตน

Help: เปนหมวดที่รวบรวมวิธีการใชงานและคำแนะนำเพื่อชวยเหลือผูใชโปรแกรม



คอนโทรลพาเนล (Control Panel)

เปนแถบตัวเลือกสำหรับกำหนดคาตางๆ ของวัตถุ เพื่ออำนวยความสะดวกแกผูใชใหสามารถกำหนดคาสี ขนาด ตำแหนง 

และคุณสมบัติตางๆ ของวัตถุที่เลือกไดงายขึ้น

พาเนลควบคุมการทำงาน (Panel)

เปนหนาตางยอยที่รวบรวมคุณสมบัติการทำงานของเครื่องมือตางๆ ใหเรา

เลือกปรับแตงการใชงานไดงายๆ ไมตองเปดหาแถบคำสั่ง ซึ่งพาเนลจะถูกจัดเก็บไวใน

กรอบจัดเก็บพาเนลดานขวาของหนาจอ



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นตรงด้วย Line Tool

ด้วย Adobe Illustrator



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นตรงด้วย Line Tool

Line Tool คือเครื่องมือส าหรับวาดเส้นตรง โดยเราสามารถก าหนดความยาวและองศา
ของเส้นให้เอียงไปยังทิศทางที่ต้องการได้ด้วย การใช้งานท าได้ดังนี้

คลิกเครื่องมือ (Line Tool) 1

คลิกเลือกขนาดของเส้น

คลิกเลือกขนาดของเส้น

คลิกเลือกสีขาว

2

3

4



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นตรงด้วย Line Tool

คลิกที่จุดแรกค้างไว้ 5

แดรกเมาส์มาอีกจุด6



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นตรงด้วย Line Tool

ปล่อยเมาส์จะได้เส้นตรง 7



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นตรงด้วย Line Tool

ท าตามขั้นตอนเดิมจนไดภ้าพตามตวัอย่าง8



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นตรงด้วย Line Tool

เราสามารถรวมเส้นเข้าด้วยกันได้โดยใช้เครื่องมือ       (Direct Selection Tool)
แดรกเมาส์ เลือกจุดแองเคอร์ทั้งสองจุด จากนั้นคลิกขวาแล้วเลือกค าสั่ง Join

เลือกค าสั่ง Join



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นตรงด้วย Line Tool

นอกจากการแดรกเมาส์สร้างเส้นตรงแล้ว ยังก าหนดค่าเพ่ือสร้างเส้นตรงได้ทั้งความยาวเส้น
และองศาการเอียงเส้น โดยใช้เครื่องมือ       (Line Tool) คลิกลงบนอาร์ตบอร์ด  เปิดหน้าต่าง
การก าหนดค่าขึ้นมา เพ่ือปรับแต่งค่าต่างๆ ได้เช่นกัน

หลังจากก าหนดค่าใน Line Segment Tool Options เพ่ือสร้างเส้นตรงแล้ว  จะเห็นว่า
เส้นที่ได้เป็นเส้นเปิด ท าให้ลงสีไม่ได้ เราสามารถแปลงคุณสมบัติของเส้นให้กลายเป็นเส้นปิดได้ 
ดังนี้ ก าหนดความยาวเส้นที่ต้องการ

ก าหนดองศาการเอียงเส้น

ก าหนดให้ใส่สีพื้นของเส้น



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นตรงด้วย Arc Tool

เครื่องมือ       (Arc Tool) ใช้ส าหรับสร้างเส้นโค้ง สามารถน ามาเชื่อมต่อกันให้เกิดเป็น
รูปภาพได้หลายรูปแบบ ดังนี้

ก าหนดค่าเริ่มต้นให้เส้น
เลือกสีและขนาดที่ต้องการ 2

คลิกเครื่องมือ 1

คลิกแล้วแดรกเมาส์สร้างเส้นโค้ง 3 เมื่อปล่อยเมาส์จะได้เส้นโค้ง4



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นตรงด้วย Arc Tool

เราสามารถปรับแต่งเครื่องมือ       (Arc Tool) ให้สร้างรูปทรงแบบปิด พร้อมกับใส่สีพื้น
ลงไปในภาพได้ ให้เปิดหน้าต่างการปรับแต่งโดยใช้       (Arc Tool) คลิกลงไปบนอาร์ตบอร์ด
มีค่าการปรับแต่งดังนี้

เลือกประเภทรูปทรงรูปทรง
เป็นแบบเส้นเปิดหรือเส้นปิด

เลือกจุด Reference 
ส าหรับจุดเริ่มต้นเส้นโค้งก าหนดความยาวเส้น

ตามแนวตั้ง และแนวนอน

เลือกด้านที่เป็น
ฐานของรูปทรง

เลือกด้านที่เป็น
ฐานของรูปทรง

ก าหนดค่าความ
โค้งของมุมเส้น



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นเส้นโค้งรูปก้นหอยด้วย Spiral Tool

เครื่องมือ      (Spiral Tool) ใช้ส าหรับสร้างเส้นโค้งรูปก้นหอย ที่มีลักษณะหมุนวนจาก
ตรงกลาง แล้วค่อยๆคลายเส้นให้หลวมออกมาด้านนอก มีหลักการง่ายๆคือ แดรกเมาส์ไปบน
อาร์ตบอร์ดเพื่อก าหนดรัศมี ดังตัวอย่าง

เลือกสีเส้นและ
ขนาดที่ต้องการ 2

เลือกเคร่ืองมือ
Spiral Tool 1

คลิกแล้วแดรกเมาส์
เพ่ือสร้างเส้นโค้ง 3

เมื่อปล่อยเมาส์
จะได้เส้นโค้ง4



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นเส้นโค้งรูปก้นหอยด้วย Spiral Tool

สามารถปรับแต่งค่า ก าหนดความโค้ง หรือความหนาแน่นของเส้นโค้งในจุดศูนย์กลางได้      
ให้ใช้เครื่องมือ       (Spiral Tool) คลิกลงไปบนอาร์ตบอร์ดแล้วก าหนดค่าต่างๆ ดังนี้

รัศมีหรือขนาดของรูปทรง

ก าหนดค่าเพ่ือควบคุมการม้วนของเส้น

ก าหนดค่าเพ่ือควบคุมความแน่น ของเส้นโค้งบริเวณจุดศูนย์กลาง

เลือกรูปแบบการหมุนเสน้



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดเส้นเส้นโค้งรูปก้นหอยด้วย Spiral Tool

หลังจากปรับแต่งค่าบนหน้าต่างค าสั่ง Spiral แล้ว ผลลัพธ์จะมีความแตกต่างกัน ดังนี้

Decay 80%
Segments 10

Decay 80%
Segments 20

Decay 80%
Segments 40

Decay 80%
Segments 60

Decay 80%
Segments 80

Decay 80%
Segments 100

Decay 10%
Segments 10

Decay 20%
Segments 10

Decay 30%
Segments 10

Decay 40%
Segments 10

Decay 50%
Segments 10

Decay 80%
Segments 10



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดตารางสี่เหลี่ยมด้วย Rectangular Grid Tool

การสร้างตารางสี่เหลี่ยม มักน าไปใช้ร่วมกับการจัดระเบียบข้อความ หรือน าไปใช้สร้างเป็น
ลวดลาย Pattern มีหลักการสร้างดังต่อไปนี้

เลือกสีเส้นและ
ขนาดที่ต้องการ 2

คลิกเครื่องมือ
Rectangular Grid Tool

คลิกแล้วแดรกเมาส์เพ่ือ
สร้างตาราง

1

3

เมื่อปล่อยเมาส์จะได้ตาราง 4



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดตารางสี่เหลี่ยมด้วย Rectangular Grid Tool

เราสามารถก าหนดค่าให้เครื่องมือ       (Rectangular Grid Tools)  ไม่ว่าจะเป็นขนาด
ตาราง จ านวนแถว หรือจ านวนคอลัมภ์ ใช้เครื่องมือ      (Rectangular Grid Tools) คลิก
ลงไปบนอาร์ตบอร์ด พร้อมกับปรับแต่งค่าต่างๆดังนี้

รัศมีหรือขนาดของรูปทรง

ก าหนดจ านวนแถวให้ตาราง
พร้อมกับก าหนดค่าความถี่ให้

ด้านบนหรือด้านล่างของตาราง

ก าหนดจ านวนคอลัมน์ให้ตาราง
พร้อมกับก าหนดค่าความถี่ให้

ด้านซ้ายหรือด้านขวาของตาราง

คลิกเพื่อใส่สีพื้นให้ตาราง
คลิกเพื่อสร้าง Bounding Box 
ส าหรับปรับขนาดตารางทีก่รอบนอก



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดตารางตารางวงกลมด้วย Polar Grid Tool

(Polar Grid Tool) เป็นเครื่องมือสร้างตารางแบบวงกลมเพื่อน าไปใช้สร้างกราฟ
หรือใช้ร่วมกับการออกแบบอื่นๆ มีวิธีการาร้างดังนี้

เลือกสีเส้นและ
ขนาดที่ต้องการ 2

เลือกเคร่ืองมือ
Polar Grid Tool1

คลิกแล้วแดรกเมาส์
เพ่ือสร้างเส้นตาราง 3

เมื่อปล่อยเมาส์จะได้ตาราง 4



การใช้งานเครื่องมือกลุ่มวาดเส้น 
วาดตารางตารางวงกลมด้วย Polar Grid Tool

หลังจากสร้างตารางวงกลมขึ้นมาแล้ว การปรับแต่งจะท าได้ค่อนข้างจ ากัด หากต้องการ
ปรับเปลี่ยนสี หรือสร้างลวดลายให้สวยงามขึ้น สามารถท าได้ดังนี้

คลิกเลือก Fill และ Stroke
เพ่ือแยกวัตถุเป็นสีพื้นและสีเส้น

คลิกเมนู Object > Expand 1

2

คลิกปุ่ม OK 3

ใส่สีพื้นให้ตาราง
ได้ตามต้องการ 4



การใช้งานเครื่องมือกลุ่มวาดเส้น 
กลุ่มเครื่องมือดินสอวาดภาพ 

ด้วย Adobe Illustrator



กลุ่มเครื่องมือดินสอวาดภาพ 
กลุ่มเครื่องมือดินสอวาดภาพมีทั้งหมด 3 ตัว มีหน้าที่แตกต่างกันคือ ใช้วาดเส้น ปรับเส้น

ให้โค้งมน และการตัดบางส่วนของเส้นออก มักน าไปใช้ในการสร้างเค้าร่าง สามารถแดรกเมาส์
ก าหนดเส้นได้อย่างอิสระ 

เลือกสีเส้นและขนาดที่ตอ้งการ 2

คลิกเครื่องมือ Pencil Tool 1

คลิกเครื่องมือ Pencil Tool 3



กลุ่มเครื่องมือดินสอวาดภาพ 
เราสามารถปรับแต่งค่าเริ่มต้นให้เครื่องมือ     Pencil Tool ได้ เพื่อให้ใช้งานสะดวก

ยิ่งขึ้น โดยดับเบิลคลิกที่เครื่องมือแล้วปรับแต่งค่าต่างๆ ดังต่อไปนี้

เพ่ิมหรือลดความนุ่มนวลของเส้น

เพิ่มหรือลดความนุ่มนวลของเส้น
แสดง Select บนเส้น
หลังจากใช้เครื่องมือแล้ว

คลิกพร้อมทั้งระบุระยะห่างให้เส้น
Path ที่วาดใกล้กันให้เหลือเพียง
เส้นเดียวหรือคลิกยกเลิกเพื่อวาด

เส้นทันกันก็ได้

คลิกเพื่อเรียกค่าเดิมกลับมา



กลุ่มเครื่องมือดินสอวาดภาพ 
เราสามารถประยุกต์ใช้เครื่องมือ     Pencil Tool วาดภาพเหมือนได้โดยน าภาพถ่ายมา

วางไว้บนอาร์ตบอร์ด ก าหนดเป็นแบบ Template หลังจากนั้นใช้เครื่องมือ    Pencil Tool
วาดเส้นแล้วน าไปตกแต่งให้สวยงามด้วยค าสั่งต่างๆ 



ปรับเส้นให้เรียบขึ้นด้วย Smooth Tool

ปรับแต่งคุณสมบัติของเครื่องมือ     Smooth Tool ดับเบิลคลิกเครื่องมือแล้วก าหนด
ค่าดังนี้

ก าหนดระยะห่างระหว่างจุด Anchor 
ค่ายิ่งสูง จุด Anchor จะน้อยลง 

เส้นจะเรียบเนียนขึ้น

คลิกเพื่อเรียกค่าเดิมกลับมา



ตัดเส้น Path ทิ้งด้วย Path Eraser Tool 

นอกจากการสร้างเส้นและปรับเส้นให้เรียบเนียนแล้ว บางครั้งอาจต้องลบบางส่วนทิ้งไป
ซึ่งสามารถใช้เครื่องมือ     Path Eraser Tool ช่วยได้ โดยมีวิธีการใช้งานง่ายๆ ดังนี้

คลิก Path
Eraser Tool

1

แดรกเมาส์ลบเส้น 
Path ออกไป

กดปุ่ม Ctrl แล้วคลิกเลือก    
ที่ท างานกับเส้น Path

2

3

เส้น Path จะถูกลบออก4



การใช้งานเครื่องมือกลุ่มวาดเส้น 
กลุ่มเครื่องมือส าหรับวาดรูปทรงเรขาคณิต

ด้วย Adobe Illustrator



กลุ่มเครื่องมือส ำหรับวำดรูปทรงเรขำคณิต
เครื่องมือวำดรูปทรงพื้นฐำน มี 3 แบบคือ

Rectangle Tool : ส ำหรับวำดรูปสี่เหลี่ยม
Rounded Rectangle Tool : ส ำหรับวำดรูปสี่เหลี่ยมขอบมน
Ellipse Tool  : ส ำหรับวำดรูปวงกลม

เลือกสีเส้นและ
ขนาดที่ต้องการ 2

คลิกเครื่องมือ
ที่ต้องการใช้งาน

1

แดรกเมาส์สร้างรูปทรง 3 เมื่อปล่อยเมาส์จะได้    
รูปทรงที่ต้องการ

4



กลุ่มเครื่องมือส ำหรับวำดรูปทรงเรขำคณิต
ตัวอย่ำงกำรใช้เครื่องมือ      Rounded Rectangle Tool

และเครื่องมือ Ellipse Tool  



วำดรูปหลำยเหลี่ยมด้วย Polygon Tool
Polygon Tool เป็นเครื่องมือส ำหรับวำดรูปหลำยเหลี่ยม ก ำหนดได้ตั้งแต่สำมเหลี่ยม

เป็นต้นไป วิธีใช้งำนเครื่องมือ ท ำได้ดังนี้

เลือกสีเส้นและ
ขนาดที่ต้องการ

2

คลิกเครื่องมือ
Polygon Tool

1

แดรกเมาส์สร้างรูปทรง   
โดยยังไม่ปล่อยเมาส์

3

กดปุ่มลูกศรข้ึนหรือลงที่คีย์บอร์ด
เพ่ือเพ่ิมหรือลดเหลี่ยมของรูปทรง

4 เมื่อปล่อยเมาส์จะ
ได้รูปทรงที่ต้องการ

5



วำดรูปหลำยเหลี่ยมด้วย Polygon Tool
กำรก ำหนดค่ำจ ำนวนเหลี่ยมมุมของรูปทรง        (Polygon Tool) ยังสำมำรถท ำได้โดย กำรคลิกลงไปบน

อำร์ตบอร์ด 

ก าหนดขนาดของรูปทรง

ก าหนดจ านวนเหลี่ยม
ของรูปที่ต้องการ



วำดรูปดวงดำวด้วย Star Tool

เลือกสีเส้นและ
ขนาดที่ต้องการ

2

คลิกเครื่องมือ
ที่ต้องการใช้งาน

1

แดรกเมาส์สร้างรูปดาว 3 เมื่อปล่อยเมาส์จะ
ได้รูปดาวที่ต้องการ

4



วำดรูปดวงดำวด้วย Star Tool

คลิกแล้วแดรกเมาส์
สร้างรูปดวงดาว

1

สามารถคลิก Ctrl เพื่อควบคุมความยาวของแฉกดาวได้อีกด้วย

กดปุ่ม Ctrl ค้างไว้ แล้ว
แดรกเมาส์เข้าหรือออก

2

สามารถเพิ่มขนาดเส้น  
และสีของดวงดาวได้

3



วำดรูปดวงดำวด้วย Star Tool

คลิกแล้วแดรกเมาส์
สร้างรูปดวงดาว

1

สามารถคลิก Ctrl เพื่อควบคุมความยาวของแฉกดาวได้อีกด้วย

กดปุ่ม Ctrl ค้างไว้ แล้ว
แดรกเมาส์เข้าหรือออก

2

สามารถเพิ่มขนาดเส้น  
และสีของดวงดาวได้

3



วำดแฟลร์ด้วย Flare Tool
แฟลร์ หรือ Flare Tool ลักษณะของแสงกระทบวัตถุให้เกิดวงของแสง หรือประกายแสง สามารถใช้งาน

เครื่องมือ          (Flare Tool)

คลิกเครื่องมือ
Flare Tool

1

คลิกแล้วแดรกเมาส์     
ก าหนดขนาดแฟรท์ี่

ต้องการ แล้วปล่อยเมาส์
2



วำดแฟลร์ด้วย Flare Tool

กดปุ่มลูกศรขึ้นหรือลง เพ่ือเพ่ิมหรือ  
ลดจ านวนแสงสะท้อนของแฟร์

4

คลิกแล้วแดรกเมาส์ที่จุดใหม่     
เพ่ือสร้างแสงสะท้อนของแฟร์

3



วำดแฟลร์ด้วย Flare Tool

กดปุ่มลูกศรขึ้นหรือลง เพ่ือเพ่ิมหรือ  
ลดจ านวนแสงสะท้อนของแฟร์

4

คลิกแล้วแดรกเมาส์ที่จุดใหม่     
เพ่ือสร้างแสงสะท้อนของแฟร์

3

เมื่อปล่อยเมาส์จะได้แฟลรด์ังภาพ5





การใชงาน Pen Tools
ภาพตางๆที่เราสรางใน Illustrator จะประกอบดวยเสน Path มากมาย เสน  Path เหลานี้จะถูกนำมาประกอบเขาดวยกันเปน

รูปรางที่ตองการ เสน Path เหลานี้สวนใหญจะถูกสรางจากเครื่องมือ        (Pen Tools) ซึ่งเปนเครื่องมือที่สามารถนำไปใชใน

งานการาฟคไดหลากหลาย และนำไปประยุกตใชกับงานตางๆ ไดมากมาย ดังภาพตัวอยาง



เริ่มตนการใชงานงานเครื่องมือ Pen tools ดวยการคลิกที่สัญลักษณ         เพื่อทำการเรียกใชงานเครื่องมือ Pen Tools

สรางเสน Path เพิ่ม Achor 

Point Path

ลบ Achor Point 

Path
ดัดมุม Achor 

Point Path

คลิกขาง

Tools Box

การใชงาน Pen Tools



ทำความรูจักกับเสน Path
กอนจะวาดรูปดวยเครื่องมือ         (Pen Tool) ตองทำความรูจักกับเสน Path กอนวามีสวนประกอบอะไรบาง เพื่อใหควบคุม

ทิศทางของเสน Path ไดงาย รวมทั้งใหสามารถวาดรูปทรงไดรวดเร็วและสวยงามยิ่งขึ้นดวย 

Direction Line คือ เสนที่ใช

ควบคุมความโคงของเสน Path 

ถาเสนยิ่งยาว เสน Path ก็จะ

โคงมาก

จุดแองเคอร ( Anchor Point) 

ที่ถูกเลือกใชงานจะเปนสีทึบ

Direction Point ซึ่งเปนจุดแสดงทิศทาง 

และใชควบคุมทิศทางของเสน Path ได

เสนโคงหรือเสนตรง (Path Segments) ซึ่ง

เปนรูปทรงของเสน Path

จุดแองเคอร (Anchor Point) ที่ไมไดเลือก

ใชงานจะเปนสี่เหลี่ยมสีขาว



ทำความรูจักกับเสน Path (ตอ)
คลิกที่        เพื่อฝกการใชเครื่องมือ Pen Tool



คลิกที่        เพื่อฝกการใชเครื่องมือ Pen Tool

ทำความรูจักกับเสน Path (ตอ)



คลิกที่        เพื่อฝกการใชเครื่องมือ Pen Tool

ทำความรูจักกับเสน Path (ตอ)



วาดรูปทรงดวยเครื่องมือ Pen Tool



วาดเสนตรงดวย Pen Tool
การสรางเสนตรงดวยเครื่องมือ        (Pen Tool) เปนวิธีที่งายที่สุด เพียงแคคลิกไปบนอารตบอรดก็จะไดเสน Path ที่เปนเสน

ตรงดังตัวอยางตอไปนี้



Work Shop : Grassed 3D 
สรางเสนตรงดวยเครื่องมือ         (Pen Tool) ตามรูป



วาดเสนโคงดวย Pen Tool
การสรางเสนโคงดวยเครื่องมือ        (Pen Tool) เปนวิธีที่งายที่สุด เพียงแคคลิกไปบนอารตบอรดก็จะไดเสน Path ที่เปนเสน

ตรงดังตัวอยางตอไปนี้

สรางเสนโคงรูปตัว U สรางเสนโคงรูปตัว S การวาดเสนตรงรวมกับเสนโคง



Work Shop | Bicycle 
สรางเสนตรงดวยเครื่องมือ         (Pen Tool) ตามรูป



Work Shop | Add Achor Point 
เพิ่มจุด Achor Pointดวยเครื่องมือ         (Add Anchor Tool) ตามรูป



ลบ Achor Point ดวยเครื่องมือ         (Delete Anchor Point Tool) ตามรูป

Work Shop | Delete Achor Point 

Tool



Work Shop | Convert Achor Point to corner 
Convert Achor Point ดวยเครื่องมือ         (Convert Anchor Point to corner) ตามรูป



-  Convert Achor Point ดวยเครื่องมือ         (Pen Tool) 

-  คลิกที่จุด Achor Point แลวไปที่         (Convert Anchor Pen Tool) 

-  ปรับแขนของจุด Achor Point  

Work Shop | Convert Achor Point 



Work Shop | Convert Achor Point 
Convert Achor Point ดวยเครื่องมือ        โดยกด ALT คางไวแลวแดรกเมาสไปยังทิศทางของจุด Direction



Work Shop | Simplify
Simplify คือ คำสั่งที่ใชแกปญหาเสน Path ที่มีรอยหยักมากๆ ใหดูเนียนเรียบขึ้น ในขณะเดียวกันก็สามารถแปลงเปนเสน Path 

ที่โคงมนใหกลายเปนเหลี่ยมมุมไดเชนกัน สามารถเรียกคำสั่งไดที่เมนู Object > Path > Simplify



Work Shop | แปลงภาพถายเปนภาพวาด
การแลงภาพบิตแมปใหเปนภาพวาด ใชคำสั่ง Image Trace คำสั่งจะคำนวณคาจากจุดสีภาพมาสรางเปนเสน Path เราสามารถ

จัดการรูปแบบไดภายหลัง ไมวาจะเปนการปรับความโคงของเสน Path การเพิ่มสีใหสวยงาม การใชคำสั่ง Image Trace 

สามารถทำไดดังนี้

1 วางรูปภาพไวบน Art Board โดยคลิกเมนู 

File > Place

2  คลิกเลือกภาพดวยเครื่องมือ Selection Tool

3 คลิกที่ปุม Image Trace บนพาแนล Control 

เพื่อแปลงภาพเปนเวคเตอร



แปลงภาพถาย

เปนภาพวาด



การจัดการวัตถุ
ดวย Adobe Illustrator



การจัดการวัตถุ : COPY

ใชเครื่องมือ Selection Tool 

คลิกเลือกวัตถุที่ตองการ Copy

1คลิกที่เมนู Edit2

คลิกเลือก Copy3

คำสั่ง วางวัตถุ4

A. วางวัตถุทั่วไป

B. วางวัตถุซอนทับตัวเดิม

C. วางวัตถุไวหลังวัตถุตัวเดิม

D. วางวัตถุไวตำแหนงเดียวกับวัตถุเดิม

F. วางวางวัตถุไวทุก ArtBoards

A

B

C
D

F



การจัดการวัตถุ : Duplicate 
: การกระทำซ้ำกับวัตถุ (Object)

ใชเครื่องมือ Selection Tool 

คลิกเลือกวัตถุที่ตองการ Copy

1

ทำการ Copy Object ออกมา 1 ครั้ง 

ดวยการคลิกวัตถุ A แลวกด alt คาง 

ใชเมาสแดรก object ออกมา จะได

วัตถุ B

2

Duplicate ไฟลดวยการกดปุม CTRL+D3

A B

A

A B D



การจัดการวัตถุ : Order
: การจัดลำดับของวัตถุ (Object)

ใชเครื่องมือ Selection Tool         คลิกเลือกวัตถุ A เพื่อจัดลำดับ1

คลิกเมาสขวา แลวไปที่เมนู Arrange2

A

B

A

C

เลือกการจัดการวัตถุตามความตองการ3



การจัดการวัตถุ : Transform

ใชเครื่องมือ Selection Tool         คลิกเลือกวัตถุ1

คลิกเมาสขวา แลวไปที่เมนู Transform2

A

เลือกการจัดการวัตถุตามความตองการ3

การเคลื่อนยายวัตถุ
การหมุนวัตถุ

การกลับดานวัตถุ

การขยาย/ลดขนาดของวัตถุ

การยืดขยายขนาดของวัตถุ



Brush
ดวย Adobe Illustrator



คลิกเลือก Brush Tool

การทำงานกับ Brush Tools

1 2 คลิกเมนู Window > Brush (F5) คลิกเลืิอก Brush ที่ตองการวาด3



คลิกเลือก Brush Library 

เพื่อเปดใชงาน Brush ชนิดอื่น

การทำงานกับ Brush Tools

4



ตัวอยางการทำงานกับ Brush Tools 



Pathfinder
ดวย Adobe Illustrator



 สรางรูป Shape ดังภาพขึ้นมา

การทำงานกับ Pathfinder

1 2 คลิกเมนู Window > Pathfinder คลิกเลืิอก การจัดการ 

Pathfinder ที่ตองการ
3

คลิกเพื่อรวมรูปทรง หรือตัดรูปทรงที่ซอนกัน

อยูในแบบตางๆ เลือกไดทั้งหมด 4  วิธี

คลิกเพื่อแยกรูปทรง ที่ซอนกันออกเปนชิ้นๆ 

เลือกไดทั้งหมด 6 วิธี

คลิกเพื่อตัดเสน Path ออกตามรูปแบบที่เรา

เลือก

 พาเนล Pathfinder คือ พาเนลสำหรัับจัดการกับรูปทรงที่วางซอนทับกัน ใหสามารถรวมกัน หรือ ตัดสวนที่ทับซอนกันออกไป 



Minus Front

การทำงานกับ Pathfinder

Intersect Exclude Devide

Trim Merge Crop Outline Minus Back

Unite


